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Introduction

About the User Manual

Welcome to Foxit Reader (MSI) -- your right choice to view and print PDF documents!
Foxit Reader (MSI) is developed on the basis of Foxit Reader (EXE) , but it extends the usability

and performance of viewing and editing of Foxit Reader (EXE). This User Manual introduces the
deployment and configuration of Foxit Reader. Please follow the instructions below for details.

About Foxit Reader (MSI)

Foxit Reader (MSI) Overview

Foxit Reader (MSI), hereafter referred to as Foxit Reader, is a PDF document viewer and printer. It
launches quickly and is easy to install. Just run “Foxit Reader Setup.msi” and then follow the
installation guides to complete installation.

Foxit Reader enables users to create, edit and secure reliable PDF documents quickly, easily and
economically. In addition to the basic PDF viewing functions, Foxit Reader also includes various
advanced features, such as RMS Protection, GPO Control, and XML Control.

Installing Foxit Reader

Windows System Requirements

Foxit Reader runs successfully on the following systems. If your computer does not meet these

requirements, you may not be able to use Foxit Reader.
Operating Systems

e Windows 7 (32-bit & 64-bit)

*  Windows 8 Full Version

*  Windows 10

. Microsoft Office® 2007 or later version (required for some PDF creation features)
*  Verified as Citrix Ready® with Citrix XenApp® 7.6

Recommended Minimum Hardware for Better Performance
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i 1.3 GHz or faster processor

* 512 MB RAM (Recommended: 1 GB RAM or greater)
* 1GB of available hard drive space

*  1024*768 screen resolution

How to Install?

>  Double-click the installation file and you will see the Install Wizard pop up. Click Next to
continue.

) Foxit Reader Setup =1

Foxit® Welcome to the Foxit Reader
Reader Setup Wizard

The Setup Wizard will install Foxit Reader on your
computer. Click Mext to continue or Cancel to exit the
Setup Wizard.

Version: 8.0.2.725

Back || Ned | | cancel |

» In order to install Foxit Reader on your system, you are required to accept the terms and
conditions of Foxit’s License Agreement. Please read the Agreement carefully and then
check | accept the terms in the License Agreement and click Next to continue. If you cannot

accept it, please click Cancel to exit the installation.
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i
I

15 Foxit Reader Setup

End-User License Agreement

Please read the following license agreement carefully

FOXIT SOFTWARE INC. LICENSE AGREEMENT FOR DESKTOP i
SOFTWARE APPLICATIONS

IMPORTANT-READ CAREFULLY: This Foxit Software Inc. ("Foxit")
License Agreement ("License" or "Agreement"} is a legal
agreement between You (either an individual or an entity, who will
be referred to in this License as "You" or "Your") and Foxit for the
use of desktop software applications, and which may include
associated media, printed materials, and other components and

| accept the terms in the License Agreement

| Back |[ mMNet | [ cancel

»  Choose one of the setup types as needed:

A. Typical —installs all features by default but requires more disk space.
B. Custom—allows users to choose the features to be installed.

15 Foxit Reader Setup o |w =

Choose Setup Type

Choose the setup type that best suits your needs

(@ Typical Install Foxit Reader with default settings. Requires the most disk
space. Recommended for most users.

(71 Custom  Allows users to choose which program features will be installed.

Install Foxit Reader to:

C \Program Filez (x8B)%Foxit Software' Change ...

[ Back ][ Install ] [ Cancel ]

»  For Typical setup, just click Install. For Custom setup, do the following:

A) Click Browse to change the installation directory of the PDF Viewer plug-in.
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B) Click Disk Usage to check the disk space available for the selected features.
C) Check the options you want to install and click Next to continue.
) Foxit Reader Setup ==

Custom Setup

Select the way you want features to be installed.

Click the icons in the tree below to change the way features will be installed.

Foxit Reader is a small, fast,
=l -| Foxit Reader PDF Creator and rich feature PDF viewer

......... gvl Shell Extensions which allows you to Dp&n,m&w,
and print any PDF file.

This feature requires 122MB on
your hard drive. It has 2 of 2
subfeatures selected. The
subfeatures require 7065KE on
your hard drive.

Location: C:\Program Files\Foxit Software\Foxit Reader

|  Reset |  DiskUsage || Back || Ned || Cancel |

D) Select the additional tasks you would like to perform while installing Foxit Reader, click
Next and then Install to begin the installation.

5 Foxit Reader Setup ==

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing the
Foxit Reader, then click Mext.

Create Deskiop lcons.
Create a Start Menu folder.

Set Foxit Reader as the default PDF viewer.

[¥] Show PDF files in browsers.

Disable ConnectedPDF features

Install as the default system printer

| Back | MNet | | Cancel
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) Foxit Reader Setup Lo )

Ready to install Foxit Reader

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

| Back || nstal | | cancel |

»  Finally, a message will appear to inform you the successful installation. Click Finish to
complete the installation.

1) Foxit Reader Setup Lo S|

Foxit® Completed the Foxit Reader
Reader Setup Wizard

Click the Finish button to exit the Setup Wizard.

The Launch Foxit Reader
Best PDF

Reader

Back || Finish ] | Cancel

Command-line Installation

You can also use the command-line to install the application:

msiexec /Option <Required Parameter> [Optional Parameter] [PROPERTY=PropertyValue]
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For detailed information on msiexec.exe options, required parameters, and optional parameters,
type “msiexec” on the command line or visit Microsoft TechNet help center.

Public Properties of the Foxit Reader MSlI installation package.

Foxit Reader installation properties supplement the standard MSI public properties to give
administrators greater control over the installation of the application.

For the complete list of standard public properties please refer to:
http://msdn.microsoft.com/en-gb/library/aa370905(VS.85).aspx

The Foxit Reader properties are:

ADDLOCAL <list of features>The value of the ADDLOCAL property is a comma delimited list
of features which the installation of Foxit Reader will make
available locally. Foxit Reader installer defines the following
features:

FX_PDFVIEWER - Foxit PDF Viewer and its components;

FX_FIREFOXPLUGIN - Plugin which is used for opening PDF files
in Mozilla Firefox, Opera, Safari, and Chrome browsers. This
feature requires FX_PDFVIEWER feature to be installed.

FX_SPELLCHECK - Spell check tool which is used for finding any
misspelled words in typewriter or form filler mode and
suggesting the correct spellings. This feature requires
FX_PDFVIEWER feature to be installed.

FX_SE - Plugins for Windows Explorer and Windows shell. These
extensions allow viewing PDF thumbnails in Windows Explorer,
previewing PDF files in Windows 7 and Office 2007. This feature
requires FX_PDFVIEWER feature to be installed.

FX_CREATOR - Foxit Reader Creator installs a virtual printer on
your system. You can use Creator to convert any printable
documents into high-quality PDFs conveniently and efficiently.
This feature requires FX_PDFVIEWER to be installed.

FX_CONVERTEXT - Shell extension which is used for converting
PDF or combining supported files from right click menu. This
feature requires FX_CREATOR to be installed.

FX_CREATORWORDADDIN - MS word toolbar add-in to create
PDFs by just one click. This feature requires FX_CREATOR to be
installed.
FX_CREATOREXCELADDIN - MS Excel toolbar add-in to create
PDFs by just one click. This feature requires FX_CREATOR to be
installed.



http://msdn.microsoft.com/en-gb/library/aa370905(VS.85).aspx
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MAKEDEFAULT

VIEW_IN_BROWSER

DESKTOP_SHORTCUT

STARTMENU_SHORTCUT

LAUNCHCHECKDEFAULT

SAFEMODE

CLEAN

AUTO_UPDATE

REMOVENEWVERSION

REMOVEGAREADER
CPDF_DISABLE

Command-line Examples:
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FX_CREATORPPTADDIN - MS PPT toolbar add-in to create PDFs
by just one click. This feature requires FX_CREATOR to be
installed.

Specifies the folder where products will be installed.

Default value of "1", Foxit Reader will be set as default
application for opening PDF files.

Default value of "1", Foxit Reader will be configured to open
PDF files inside browsers.

Default value of "1", installer will place a shortcut for the
installed application on Desktop.

Default value of "1", installer will create program menu group
for installed application and its components.

Default value of "1", Foxit Reader will check if the Reader is the

default reader when it’s launched.

Default value of "1", Foxit Reader will run in the Safe Reading
Mode.

Executes with the command /uninstall, removing all of Reader’s
registry data and related files with the value of “1”. (Note: This is

a command for uninstallation.)

Do not download or install updates automatically with the
value of “0”; Automatically download updates, but let users
choose when to install them with the value of “17;

Automatically install updates with the value of “2”.

Forces an installation to overwrite the higher version of Foxit

Reader with the value of “1”.

Forces to uninstall Foxit Reader (Desktop Version).

Disables the ConnectedPDF features by setting the value to “1”.

1. Silently install the application (no user interaction) to folder "C:\Program Files\Foxit Software":

msiexec /i "Foxit Reader.msi" /quiet INSTALLLOCATION="C:\Program Files\ Foxit Software "
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2. Install Foxit PDF Viewer only:
msiexec /i "Foxit Reader.msi" /quiet ADDLOCAL="FX_PDFVIEWER"
3. Force an installation to overwrite the same or higher version of Foxit Reader:
msiexec /i "Foxit Reader.msi" REMOVENEWVERSION="1"
4. Remove registry and user data when performing silent uninstallation:

msiexec /x "Foxit Reader.msi" /quiet CLEAN="1"

Deployment and Configuration

Using Group Policy

What is Group Policy?

Group Policy (GPO), a feature of the Microsoft Windows NT family of operating systems, is a set

of rules that control the working environment of user accounts and computer accounts. It offers
the centralized management and configuration of operating systems, applications, and users'

settings in an Active Directory environment.

Group Policy can configure most system settings, save power by utilizing smart power settings,
give individual users more control over their machines with administrator privileges and increase

system security.

Group Policy in part controls what users can and cannot do on a certain program to accomplish
the goal of central management of a group of applications. Users can configure Foxit Reader
easily through Group Policy. Please refer to the instructions below for details.

Personal Computer Setting

Foxit Reader offers two types of group policy template: .adm and .admx. Different types are
compatible with different operation systems, but have the same settings. The template of .adm
file type is compatible with Windows XP and later, while .admx is compatible with Server 2008,
Server 2012, Windows 7 and later.

Set Template Preference

For .adm file, follow the steps as below:
e  Please click Start > Run or use the shortcut key Windows + R and type gpedit.msc to open
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Local Group Policy Editor.

e  Right-click the management template and choose Add/Remove Templates in the context

menu. In the opened dialogue box, add the group policy template of Foxit Reader (Foxit

Reader.adm). The Foxit Reader template will appear in the left navigation pane and you can

set its template preferences.

£[ Local Group Palicy Editor

File Action View Help

e« B = H =T

5[ Local Computer Policy
4 & Computer Configuration
» || Software Settings
> | Windows Settings
a4 || Administrative Templates
. [ Control Panel
o [ MNetwork
| Printers
o [ System
> | Windows Components
a || Classic Administrative Templates (ADM)
a || Foxit Reader 8.0
| Plugin
| Preferences
- [ Ribbon
- [] RMS
3 All Settings
4 4, User Configuration
> || Software Settings
> | Windows Settings
» [ Administrative Templates

~ Foxit Reader 8.0

Select an item to view its description.

4 nr 2

Setting

| Plugin

| Preferences
"I Ribben
SIRMS

\ Extended /(Standard /

For .admx file, put the .admx file in C:\Windows\PolicyDefinitions and do the setting. The .admx

file should be used in combination with an .adml file. And the .adml file should be put in

C:\Windows\PolicyDefinitions\language. For example, if in the English OS, the .adml file should

be put in C:\Windows\PolicyDefinitions\en_us.

See Set Plugins as an example for other options are configured in the same fashion.

e  Choose Foxit Reader 8.0 > Plugins.

e  Double-click Remove Plugins to open the dialog box.

> Select Enabled, check the submenus to be removed in the Options, and click OK or Apply.

The corresponding submenu items will then be removed from Foxit Reader.

Note: If you select all the submenus in the Options and confirm the configuration, all of the

submenus under Page Display will be removed.

> If you select Disabled or Not Configured, no changes will be applied to Foxit Reader.





Foxit Reader Deployment

and Configuration

(=] Local Group Policy Editor & Remove Plugins = %
File Action View Hel
P [E] Remove Plugins
ez 2@=BmlT
=/ Local Computer Policy = Plugins © Not Configured  Comment: .
4 & Computer Configuration . st i
. (7] Software Settings Remove Plugins ing ©) Enabled
g [ Remove Specific| | _ p
- m"m: Sf“‘”fs e | it iy seting ) R Phagine | © DE8E1=d
4 Administratve Templetes - Supported on: picrosoft Windows XP SP2 o later R
» [ Control Panel Requirements:
+ [ Network Microsoft Windows XP SP2 or later -
| Printers
O System Description: Optiens:
- Enable this option to remove selected
» [ Windows Component | oy, sin. : _
4 ] Clossic Administrative Updater = [Enable this optian to remave selected plugins. -
4 ] Foxit Reader80 :
LicenseManager
7 Plugins
7| Preferences Read Out Loud
» [ Ribbon
.5 RMS RMS Version 2
7 Preferences SharePoint
4[] ConnectedPDF E
| Preferences Facebook
% All Settings Docusign

4§ User Configuration
. [ Software Settings
» [ Windows Settings
» (] Administrative Templates

< i

Comments Summary
DropbexPlugin
EpubViewer

FoxitCloudLegin

", Bdended { Standard

2 setting(s)

Note: Group Policy setting includes computer configuration and user configuration. Computer

configuration takes precedence over user configuration. The application will use the computer

configuration if both the computer and user configure a specific function at the same time.

GPO Deploym

ent (for Server)

Create GPO Management

e If you already have an Active Directory domain and organizational unit configured, please

skip to “Apply the Foxit Template” section.

e Choose Start > Administration Tools > open “Active Directory Users and Computers” >

right-click the field “wx.com” > choose New > Organization Unit in the right-click menu.
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=
File Action View Help
e 7m0l = Hmteaurah
] Active Directory Users and Comput | Name | Type | Desaiption l
[ ‘, Saved Queries | Builtin builtinDomain
® e A, e Container Default container for upgr...
? Conttrol... Controllers Organizational Unit Default container for dom...
ityPrincipals Container Default container for secu. ..
9e Doman.. oller Service Accounts Container Default container for man., ..
Change w Cnn‘h' Organizational Unit
Organizational Unit
Operations Masters,,, Organizational Unit
Nev ] computer Container Default container for upgr...
&ll Tasks »  Contact
Group
Wiew " InetorgPerson
Refresh msImaging-PSPs
Export List... MSMQ Queue Alias
) Organizational Unit
Properties Bri
Help User
Shared Folder
I — 2
[Creates a new item in this container.

e In the opened New Object-Organization Unit dialogue box, type the unit name (For this
example, we have named the unit “ga”) and click OK.

i)
File Action View Help
o | Hm BB = HE 385 TFTIR
j Active Directory Users and Comput | Mame I Type I Description |
|| saved Queries [ Builtin builtinDomain
.ii Wx.com [ Computers Container Default container for upar...
BLSS = " Default container for dom...
Mew Object - Organizational Unit x| Default container for secu
Default container for man...
-{rl Createin:  wx.com/
Name: Default container for upar...
Joe
[V Protect container from accidertal deletion
ok | canca | Hep |
KN =

e Rightclick the created organization unit “ga” and choose New > User in the right-click menu.
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For this example, we have named the user “King”.

B Active Directory Users and Computers - |EI|1|
File Action View Help
@ [ HE &0 XD =BFBRE5TIS
j Active Directory Users and Comput | MName | Type | Description |
[ saved Queries = :
it x
[ Builtin
7] Computers )
[2] Domain Controllers Createin:  wi.com/ga
"] ForeignSecurityPrincipals
| Managed Service Accounts
Bl First name: ijng Initials:
] gat
5] ga2 Last name: I
| Users
- Full name: ijng
User logon name:
Ik.ing I@wx.com j
User logon name {pre-Windows 2000):
|'m<\ Ik.ing
< Back Next > Cancel |
KN I— 2
=

File Acton View Help

ez FE O REd=BHE e s5Ta%
j Artive Directory Users and Comput
|| Saved Queries

= & wa.com E_']Wj User
7] Builtin wa User
::l Computers 3‘) Wy User
[ Domain Controllers 3‘ Wi User
[ ForeignSecurityPrindpals Ei )
] Managed Service Accounts #ang xin User

B wq Computer
. 1 %
2] gal ﬂ:‘ wy Computer
5] qaz [1R=WY] Computer
[ Users
K b

e Click Start > Programs > Administration Tools > open the Group Policy Management
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Console and right-click the created organization unit “ga” and choose Create a GPO in this

domain, and Link it here.

E Group Policy Management

ZL File  Action View Window Help

Y EEIEE ENE =

_§£ Group Policy Management qa
2 A\ Forest: w.com Linked Group Policy Objects
El (&4 Domains
Bl g wx.com Lk Order ~ | G
2| Domain Controllers 1 I
Create a GPQ in this domain, and Link it here...
2/ q Linkan Existing GPO...
=t & Block Inheritance
=R
B 5  Group Policy Modeling Wizard...
fﬁ Sites Mew Organizational Unit
ﬁh Group Po \icw »
£ Group PO e Window from Here
Delete
Rename
Refresh
Properties
Help
KN [

|Create a GPO in this domain and link it to this container

If you cannot find the Group Policy Management in Administration Tools, please install the

application package GPMC.MSI.

You can download the package by clicking the link

http://www.microsoft.com/en-us/download/details.aspx?id=21895.
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Apply the Foxit Template

Foxit Reader

Eﬂ Group Policy Management

~— Active Directory Users and
“ Computers

p‘f{ Foxit Reader 5.1
@ﬂ Internet Explorer

Command Prompt
.;.] Notepad

Active Directory Domains and

i |L
m Trusts
% iSCSI Initiator

=l
o- | Microsoft Outlook 2010
L

i% Local Security Policy

Foxit Reader Deployment and Configuration

£, DNs
2] Event Viewer
E Group Policy Management

iSCSI Initiator
= Local Security Palicy
i (%) Performance Monitor
i Security Configuration Wizard

, Documents i Server Manager
_.-( Services
Computer ‘3| Share and Storage Management
e ' Storage Explorer
System Configuration
Control Panel (£) Task Scheduler

ﬂ Windows Firewall with Advanced Security
|3 Windows Memary Diagnostic
E Windows PowerShell Modules
- @ Windows Server Backup

Devices and Printers

Administrative Tools

Help and Support

Run...

» All Programs

I Search programs and files

[!_ﬂ] Shut down Pl

e  Type the GPO name in the New GPO dialogue box and click OK.

x|
Mame:
Ireader
Source Starter GPO:
I{none) j

e  Right-click the new GPO and choose Edit in the right-click menu to open Group Policy Editor.
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3L File Action View Window Help

E Group Policy Management

=10l |
=181x]

LI EERE

_ﬁ Group Policy Management

qa
= _ﬁ Forest: wi.com
Bl [£4 Domains
= _f:j W, Com
[2] Domain Controllers
= (2] qa
&
[5] gat Edit... -
5] qa2 Enforced
[5r Group Pt Link Enabled =7
[ WMIFilter:  save Report...
[ Starter GP
[ sites New Window from Here
U:,'." Group Policy Mode —
[#| Group Policy Resul T
Refresh
Help

Linked Group Policy Objects IGmup Policy Inheritancel Delegation I

Link Order =

| gPo

| Enforced | Link Enabled | GPO Status | Wi

<

1 x| reader

Mo Yes Enabled Mo

e  Right-click the Template Management and choose Add/Remove Templates to add Foxit
Reader.adm. Please refer to Set Template Preference.
—
- Local Group Pali
File Action View Help
=268 Hol 7
5/ Local Computer Policy | Administrative Templates
4 & Computer Configuration
4 4 Software Settings Select an item to view its Setting
v (7] Windows Settings description [l Contral Panel
B3 Administrali\{e Templates [ Desktop
R L‘Jsesr (fi;:ﬂgusratmn = Network
’ J ottware attlrngs "I Shared Folders
©» [ Windows Settings
“ﬁ‘ [ Start Menu and Taskbar
ministrati
» O Control P: Add/Remove Templates.. [ system
& [ Desktop Filter On ZIWindows Components
» [ Network Filter Options... "1 Classic Administrative Templates (ADM)
] Shared Fg Re-Apply Filter 2 Al Settings
SStartMen ) asks ,
v [ System
b [ Windows View b
3 4 Classic A Export List.
Sz All Settin
Help
< 11 >
Extended Standard/
Manage administrative templates
e  For configuring options, please refer to Example: Set Plugins.

GPO Items

The following table shows the deployable options and their functions in GPO to speed up your

working process.
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Items in GPO Template

Folder Path

Item

Description

Foxit Reader >
Plugins

Remove Specific
Plugins

Input the plugin name which needs to be
removed.

Only applications with .fpi extensions can be
removed from Foxit Reader.

Remove Plugins

Remove selected plugins.

Foxit Reader >
Preferences

'About Foxit
Reader' Dialog

Set the new contents in 'About Foxit Reader'
dialog.

Foxit Reader >
Preferences

Default PDF

Viewer

Set Foxit Reader as the default PDF viewer for
'System PDF Viewer' and 'Web Browser PDF
Viewer'.

Foxit Reader >
Preferences

Forbid Checking
of Default PDF
Viewer

Hide the 'Set to Default PDF Reader' dialog when
Foxit Reader isn't the default PDF viewer.

Foxit Reader >
Preferences

Program Name

Change the program's name. The default is 'Foxit
Reader".

Foxit Reader >
Preferences

Remove
'Registration’

Forbid 'Registration' dialog and remove
'Registration' item from 'Help' tab.

Foxit Reader >
Preferences

Advertisement

Change the settings of advertisement in right
corner of the tab bar.

Foxit Reader > Start Page Change the settings of Start Page.
Preferences
Foxit Reader > Enable Safe Change the settings of Safe Reading Mode.

Preferences

Reading Mode

Foxit Reader > Status Bar Change the settings of Status Bar.
Preferences

Foxit Reader > Application Change the application language settings.
Preferences Language

Foxit Reader >

Preferences

Change The Link
For User Manual

Enable this option to change the link of User
Manual to the local link you want.

Foxit Reader >

Preferences

Disable the
Automatically
Update

Enable this option to disable the Automatically
Update. With this option checked, the
Automatically Update will be disabled.
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Foxit Reader >
Ribbon

Hide the selected button items in Ribbon Mode.

Foxit Reader > Save As Turn on the Save As feature for RMS protected
RMS > files.
Preferences
Foxit Reader > Forbid Web Forbid viewing of protected content in browsers
RMS > Viewing of using the Foxit plugin.
Preferences Protected

Content
Foxit Reader > Encrypt Encrypt document metadata. This disables the
RMS > Metadata setting in 'Preferences > RMS Setting'.
Preferences

Foxit Reader >
RMS >
Preferences

Add ‘protected’
to the name of

encrypted files

Append “(protected)” to the end of the file name

of encrypted files.

Foxit Reader >
RMS >
Preferences

Microsoft IRM
Protection

Enable this option to use the Microsoft IRM
Version 1, which is a Microsoft extension to the
PDF format to support Microsoft IRM protection.
The extension allows PDF documents to be
encrypted by Microsoft IRM technology that is
implemented by Microsoft’s Active Directory
Rights Management Server as well as by Azure
Active Directory Rights Management Services. If
not defined, Microsoft IRM Protection Version 2
(PPDF) is used.

Foxit Reader >
RMS >
Preferences

RMS

Interoperability

If you enable this option, all the encrypted PDFs
will conform to Microsoft IRM Protection for PDF
Specification and hence be able to be decrypted
by other RMS Viewer.

Foxit Reader >
ConnectedPDF

Disable
ConnectedPDF
features

Enable this setting to disable all ConnectedPDF
features.

Foxit Reader >
ConnectedPDF
> Preferences

Share usage data
when using
Connected
features

Enable this option to disable sharing usage data
when using ConnectedPDF features.

Foxit Reader >
ConnectedPDF
> Preferences

Automatically
save PDF files in
ConnectedPDF
format

Enable this option to forbid the application
automatically save PDF files in ConnectedPDF
format.

Foxit Reader >
ConnectedPDF

Automatically
convert Office

Enable this option to forbid the application
automatically  convert  Office files to

17






Foxit Reader Deployment and Configuration

> Preferences files to ConnectedPDF format when converting to PDF
ConnectedPDF files.
document
Using XML Editor

Besides GPO Configuration, users can also configure Foxit Reader with XML Configuration. XML
configuration takes precedence over GPO configuration. The application will use the XML
configuration if the XML, GPO and Customization Tool configure a specific function at the same
time.

The XML file in Reader’s folder (C:\Program Files (x86)\Foxit Software\Foxit Reader\ProfStore)
can be configured with XML Editor. The configurable items of XML file are the same with GPO,
please refer to GPO Items for details.

To configure a XML file with XML Editor, please follow the steps below:

e  Open the XML Editor.

e  Click Import to import the XML file to be configured. Please ensure that the XML file you
import is compatible with your currently-used version of Foxit Reader. If not, you should
change the version number to the one of your currently-used application in the Version box
(the version number should be 8.x.x).

XML Editor-Foxit Reader e

Preferences l Ribbon Set | Plugins |

Version of Foxit Reader: |8.D.D

About Foxit Reader Options
Advertisement

Application Language i
Default PDF Viewer oz

Forbid Auto Update |
Forbid Default Checking

Main Program Mame

Registration Content:
RMS Setting
Safe Reading Mode |
Set User Manual Link

Start Page

Status Bar Logo Path:

ConnectedPDF |
Browse

Description
Set the new contents in 'About Foxit Reader' dialog. -

Copyright: Change the content of copyright. The default is Foxit L
information. S
Content: Change the contents under copyright information. The B
default lists the technology built in Foxit Reader.

mp Export Interface Cancel Help
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e Set the preferences in the corresponding menus. For example, choose Preferences Tab >
click Start Page on the left panel > check Hide Start Page to remove the start page from
Foxit Reader.

e  Click Save to save the configured XML file.

Note: (Alternatively) You can configure relevant items by XML Editor directly, then export and
save the XML file in C:\Program Files (x86)\Foxit Software\Foxit Reader\ProfStore to replace the
default XML file of Foxit Reader.

Using Foxit Setup Customization Tool

You can use the Foxit Setup Customization Tool to configure the installer prior to deployment for
organizations or businesses. For example, you can license the product on a volume scale with the
Foxit Setup Customization Tool to prevent the need to register and personalize each copy of the
installation.

To download the Foxit Setup Customization Tool, please visit Foxit Knowledge Base at
https://help.foxitsoftware.com/kb/generate-transform-mst-files-via-customization-wizard.php.

To configure Foxit Reader with the Foxit Setup Customization Tool, please follow the steps
below:

e Open the Foxit Setup Customization Tool.
e  Click File > Open to open the application (MSI file) that you want to customize.
e  Open the following panels to customize the related settings in Foxit Reader.
» General: Customize the default location and other common settings.
> Features: Specify whaich features will be installed by default.
»  Shortcuts: Choose whether to create a specific shortcut.
»  Add File: Add your own files into the MSI package.
e  Click File > Save to save the customization. The customized package will be saved as an MST
file.
e  Use the following command to apply the MST file during deployment:
msiexec /i Setup.msi TRANSFORMS=Setup_FCT.mst
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.ﬁ Foxit Setup Customization Tool — =

File Help

General
Features rChange Install Location
Shortcuts

Add File

—Additional Tasks

¥ Create Desktop Icons.

[V Create a Start Menu folder.

[V Set as the default PDF viewer

¥ Show PDF files in browsers.

[~ Install as the default system printer

[~ Disable Auto Update

—Add Activation Key

—Replace ProfStore.xml

Note:

1. The customized MST file needs to be deployed with the original MSl file.

2. Foxit Setup Customization Tool is only available for Foxit Reader 7.3 and newer versions. To
ensure successful customization, the version of the Foxit Setup Customization Tool should be
same as that of Foxit Reader.
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Contact Us

Feel free to contact us should you need any information or have any problems with our products.
We are always here, ready to serve you better.

o Office Address:
Foxit Software Incorporated
42840 Christy Street. Suite 201
Fremont CA 94538
USA

e Sales:
1-866-680-3668 (24/7)

e Support:
1-866-MYFOXIT or 1-866-693-6948 (24/7)

e Fax:
1-510-405-9288

o Website:
www.foxitsoftware.com

e E-mail:

Sales and Information - sales@foxitsoftware.com

Technical Support - Input a trouble ticket online

Marketing Service - marketing@foxitsoftware.com
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Before using the check in/check out features in Foxit Reader/PhantomPDF, please
configure the SharePoint Server.

¢ Download PDF icon from
https://www.foxitsoftware.com/resource/images/icons/pdficon.qif.

e SharePoint 2007: Copy the downloaded.GIF file to "Drive: \Program Files\Common
Files\Microsoft Shared\Web Server Extensions\12\Template\Images".

SharePoint 2010: Copy the downloaded.GIF file to "Drive:\Program Files\Common
Files\Microsoft Shared\Web Server Extensions\14\Template\Images"

e SharePoint 2007: Edit the file “Drive:\Program Files\Common Files\Microsoft
Shared\Web server extensions\12\Template\XmN\DOCICON.XML".

¢ SharePoint 2010: Edit the file “Drive:\Program Files\Common Files\Microsoft
Shared\Web server extensions\14\Template\XmN\DOCICON.XML".

¢ SharePoint 2013: Edit the file “Drive:\Program Files\Common Files\Microsoft
Shared\Web server extensions\15\Template\XmN\DOCICON.XML”.

To edit the file, please refer to the following steps:
a. Right-click DOCICON.XML file > click Open With > select Notepad.

b. Add an entry for the file with .pdf extension and take it as the file’s name. For
example, type the ICPDF as the name of the .gif file:

<Mapping Key="pdf" Value="pdficon.gif"

OpencControl="FoxitPhantomPDF.OpenDocuments"/>
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DOCICON - Notepad =10 x|
Fle Edit Format View Help

<?xml version="1.0" encoding="utf-8"?> -
<DocIcons>
<BYProgID>
<Mapping Key="Excel.sheet" value="ichtmxls.gif" EditText="Microsoft Excel" OpencControl="sharepoint.OpenDocuments"
<Mapping Key="FrontPage. Editor.Document” value="' 1chtmfp .gif" EditText="VMicrosoft sharepoint Designer opencontrol:
<Mapping Key="1InfoPath.Document” value="1 rosoft Infopath” opencontrol=
<Mapping nfopath. bocument. 2" icrosoft Infopath” oOpencContro
<Mapping . icrosoft Infopath" opencontro
<Mapping nfopath. Document.4" value: .gi i 1icrosoft Infopat
<Mapping 3 " i microsoft Excel” opencControl=
<Mapping Keyf 'ODC. Database™ Ed1tText7 "Microsoft Excel” Opencontru'lf sharepoint. OpenDo(uments
<Mapping Key="0DC.Table" value: EditText="Microsoft Excel" OpenControl="sharepoint,openDocuments"/>
<Mapping Key="Onenote.Notebook" value="icnotebk.png" EditText="Microsoft OneNote" OpenControl="sharePoint.Openboct
<Mapping Key="PowerPoint.slide" value 81 " _EditText="Microsoft PowerPoint” opencontrol="sharepoint.opent
<Mapping Key="Publisher.Document” value="ichtmpub.gif" EditText="Microsoft Publisher” Opencontrol="sharepoint.ope
<Mapping Key="sharePoint.Documentset” value="icdocset,gif"/>
<Mapping Key="sharepoint.webPartPage.Document” value=" icsmrtpg. gif" EditText="Microsoft_sharepoint Designer" opernt—
<Mapping Key="visio. webDrau1ng value="icvdw.gif" EditText=" "Microsoft visio opencontrol="sharePoint.Openbocument:
<Mapping Key="word.Document" Value="ichtmdoc.gif" EditText="Microsoft word" openControl="sharePoint.openDocuments’
<Mapping Key="XDocs.Document" value="jcxddoc.gif" EditText="Microsoft Infopath" opencontrol="sharepoint.0openxMLDo¢
<Mapping Keyf ‘sharepoint.Link” value="DOCLINK.GIF
<Mapping Key="sharepoint.SearchadminReport” value="icsadrep.gif" EditText="Microsoft Sharepoint Designer" OpencConi
</BYProgIp>

<ByExtension>
<Mappin Keyf accdb" value="icaccdb.gif" EditText="Microsoft Access" opencontrol="sharepoint.Openbocuments" />
i "accdt” if"/>

opencontro
harepPoint.Openbocuments” />

<Mapping Key="pdf" value="pdficon.gif" opencontrol="FoxitPhantomPDF.Openbocuments"

.gif" EditTex

i Microsoft Access" oOpenControl="sharePoint.OpenDocuments" />
g1f EditTex

Microsoft Access" opencontrol="sharepPoint.OpenDocuments" />

icasax.gi
icascx.gif"”
icasmx. ?1f
ichtm. gif" opencontrol=
"ichtm. g1f" EditText=
icbmp.gif"/>

iccat.gif" opencontro
hm. gif" opencontro

/>
osoft sharepoint Designer™ opencontrol="sharepPoint.openDocum

M1crosoft sharepoint Designer"” opencontrol="sharePoint.OpenDocumer

icconfig.gif" opencol
§1f opencontro
opencontro]-

81
1cd15c g1f opencontrol=""/>

icdoc. png EditText= M1(r050f( word" 0pen(ontro17 sharepoint.openbocuments”
icdocm. png” EditText="Microsoft word” OpenControl="sharepPoint.OpenDocument
icdocx.png” EditText="Microsoft word"” openControl="sharepPoint.0OpenDocuments"/>
cdot. png crosoft word"” opencControl= harepoint.openDocuments"/>
icdotm. png” Microsoft word" oOpencontrol="sharepPoint.OpenDocuments” />
<Mapping Key="dot icdotx.png” 1crosoft word" opencontrol="sharepPoint.OpenDocuments"” />
<Mapping Key="dvd" icdvd. gif" opencontro e

<« | M

c. Click Save on the File menu, and then quit Notepad.
Perform an iisreset:

a. Click Start > Run > type “cmd” in the Open dialog box>click OK > type
“lisreset” in the command prompt window>click Enter.

Microsoft Windows [Uersion 5.2.37901
(C) Copyright 19852083 Microsoft Corp.

E:“Documents and Settings“Administratoriiisreset
Attempting stop...

Internet services successfully stopped
Attempting start...

Internet services successfully restarted

E=“Documents and Settings“Administrator>_

b. Close the windows.
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Web Service Configuration

To use the features of dynamic revocation, number of accesses and number of prints (additional
access rights control), you should configure the web service and SQL first. Please follow the steps
as below:

1. Configure the Web Service on your on-premise RMS server.

a) Logon RMS server as Administrator.

b) Download the Web Service zip from:
For X86:
http://cdn01.foxitsoftware.com/pub/foxit/rms/configtool/8.x/WebService 32.zip
For X64:
http://cdn01.foxitsoftware.com/pub/foxit/rms/configtool/8.x/WebService 64.zip

¢) Unzip the Web Service zip and get the fxrmsext from it.

d) Copy the fxrmsext to C:\inetpub\wwwroot\_wmcs.

[ &M= _wmcs
“ Home Share View
®© - 1| » Computer » Local Disk(C:) » inetpub b wwwroot » _wmes b v c‘,| [ search_
a

' Favorites Mame Date modified Type Size

B Desktop admin 8/2 9:10 AM File folder
& Downloads certification Al File folder
= Recent places decommission File folder

frrmsext File folder

= Libraries groupexpansion File folder
5 Documents licensing File folder
& Music 3 web.config XML Configuratio... 1 KB
&) Pictures

e) Run “Internet Information Services” (IIS).
f) Right-click “_wmcs”, and then choose “Add Application...”.
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& » DRS » Sites » DefaultWebSite » _wmcs »

File View Help

Q,_- =TEAY H? /_wmcs Home
g ?ﬂ Start Page .
i Filter: - W Go - Show All | G g
493 DRS (FRMS\administrator) fer o - Show All | Group by: Area
----- [} Application Pools ASP.NET
a-[8] Sites . @ - r'\ 15
. ic 2 @ F K
{E _wmcs MNET MET] .MET Error MET MET Profile  .MET Reh
b acﬂ Explore ilgtion Pages Globalization
4 "? b Edit Permissions...
I+ é“ d
Dn‘? gr|_n§ Add Application...
b lig ;7 Add Virtual Directory...
Dﬂ CertE Manage Application »
bP CentS|[E  Refresh @ o
K Remove entic... Compression  Default Directory  Error Pag
2 Switch to Content View Document  Browsing
=
- =
Request  S5L Settings
Filterinn

g) Input the following information into the Add Application dialog box.
® Alias: fxrmsext
®  Physical path: C:\inetpub\wwwroot\_wmcs\fxrmsext

Site name:  Default Web Site
Path: f_wmcs

Alias: Application pool:
(frrmsext | |_DRMSAppPOoI

Example: sales

Physical path:
| Chinetpub\wwwroot\_wmcs\frrmsext

Pass-through authentication

‘ Connect as... ‘ | Test Settings...

["] Enable Preload

h) To avoid repeated authentication, we should disable the Windows Authentication and
enable the Anonymous Authentication. Click “fxmsext” in Connections Pane, and then
double-click “Authentication”.

NOTE: For data communication security, PDFs will be encrypted with AES algorithm by
default.





2. Configure the SQL.

a)
b)

@ » DRS » Sites » Default WebSite » _wmes » furmsext »

File  View Help
@-H|x|8
----- E Start Page

495 DRS (FRMS\administrator)
-[Z} Application Pools
‘@ Sites

€ Default Web Site
) @ _wmcs
D@ admin
|‘> @ certification
D@ decommission
b@ groupexpansion

Cll
[:> | CertEnroll
I+ @ CertSrv

Enable the “Anonymous Authentication” and disable the “Windows Authentication”.

/_wmcs/fxrmsext Home

Filter: = W Go -5l ShowAll | Group by: Area ~ [~
ASP.NET
nY - o
5 B ® @
s S ¢ K © 2
NET NET .MET Error MET .MET Profile  .MET Roles  .NET Tr
Authorizat... Compilation Pages Globalization Level
=]
SMTP E-mail
115
3 o = (4]
= @ =) a4
ASp brpression  Default Directory  Error Pages Failet
Document  Browsing Request”
%‘ & | Configure authentication settings for sites and applications |
Request 550 Settings
Filterinn

[ » DRS » Sites » Default WebSite » _wmcs » furmsext »

File  View Help
@ -z
o ?ﬂ Start Page

195 DRS (FRMS\administrator)
@ Application Pools
4.[8) Sites

4 Default Web Site
A@ _wmcs
D@ admin
D@ certification
ST " —

Authentication

Group by: Mo Grouping =

MName - Status Response Type
Ancnymous Authentication Enabled

ASP.MET Impersonation Disabled

Forms Authentication Disabled HTTP 302 Login/Redirect
Windows Authentication Disabled HTTP 401 Challenge

Navigate to C:\inetpub\wwwroot\_wmcs\fxrmsext.
Right-click “Web.config” file -> “Open with” -> “Notepad”.





furmsext

Share View
, v Computer » Local Disk (C:) » inetpub » wwwroot » _wmcs » furmsext Y] G| E
MName Date modified Type Size
J bin /2014 7:34 AM File folder
ds #| fermsextservice.asmx 014 10:18 PM ASP.NET Web Ser... TKB
aces j Web.config S COMFIG File 2KB
Open
Edit
Tts Open with b | e Microsoft Visual Studio 2010
Restore previous versions | j Motepad
Send to 3 Choose default program...
Cut
Copy

Create shortcut
Delete

Rename

Properties

¢) If you want to log on to the SQL Server through Windows Authentication, you just need
to alter the SQL Server information by inputting the IP address or computer name and
then saving the change.

<appSettings>
<add key="MyDB"

value="Servers5QL2005; DataBase=RMSExtService;

Integrated Security=SSPI; Persist Security Info=False" >
</add>

NOTE: If the computer name include =), please ensure you are using SQL 2012 version or
higher.
d) If you want to log on to the SQL Server through SQL Server Authentication, please
follow the steps:
i. Copy “Server=SQL2005; DataBase=RMSExtService; User ID=myUsername;
Password=myPassword”.
ii. Paste and replace “Server=SQL2005; DataBase=RMSExtService; Integrated
Security=SSPI; Persist Security Info=False”.

fie Edt_Fomat View Help
<?xml version="1.0"?>
<configuration>
<lan
|"SeNer\=SQL2205; DataBase=RMSExtService; User ID=myUsername; Password=myPassword"
-

<appSettings> \
<add key="MyDB"
values"Server=50L208085; DataBase=RMSExtService; Integrated Security=SSPI; Persist Security Infn=False"|>
</add>

</appSettings>

iii. Alter the SQL Server information. You can input the IP address or the computer

name.
iv. Alther the “User ID” and “Password”.
V. Save changes.

e) Create the data base and tables.
i Log on to the SQL Server as Administrator.





Get the .sql file from the Web Service zip you downloaded before.

. . g . “ ”
iii. Double-click this file to create the database and tables, and then click “Execute”.
In CreateDatabaseRMSExtService.sql - DRS.RMSExtService (sa (53)) - Microsoft SQL Server Management Studio (Administrator) == -
File Edit View Query Project Debug Tools Window Help
PG - 5 b @ | ) NewQuery [y 55 0 | 4 G2 3|9 - o - G- @ 2
i %) U | [RMSEdService -l ¥ Execute | b Debug =
Object Explorer s CreateDatabaseRMSE.. xtService (sa (33)) X _
Connect> 3 &) m 7 (2] ' Jlif object_id( RMSExtService') IS NULL +
%1 | ) AppMng Service DB 12225206c2d040b0e3de250a68¢12ed |~ EEEATE DATABASE RiSExtService -
[+ LJ Bdc_Service_DB_50bbb629ede74caeda729501bbdc9el3
# |1 DRMS_Config_drs_frms_com_443 CREATE TABLE [RM
¥ L_I DRMS_DirectoryServices_drs_frms_com_443 GO o =
# | DRMS_Logging_drs_frms_com_443
# [ Managed Metadata Service_b112d53219884fc698b639dasted] _ SIIF not exists(select * from [RMSExtService].[dbo].[ConfigurationInfo])
# [J PerformancePoint Service Application_087793ecSc3f4c6c8988 = INSERT INTO [RMSExtService].[dbo].[ConfigurationInfe]([RevocationInterval
@ [ ReportServer Go
# 1 ReportServerTempDB ICREATE TABLE [RMSExtService].[dbo].[DocInfo]([ContentID] [varchar](5@) O
= [ RMSExtService: [TemplateName] [varchar](5@) NOT NULL,
# [ Database Diagrams [Creator] [varchar](5@
# [ Tables [FileName] [nvarchar](58) NOT HULL,
= 3 Views [CreateDate] [datetime] NOT NULL,
% [ Synonyms [PrintTimes] [int] NOT NULL,
# [ Programmability [OpenTimes] [int] NOT NULL,
= @ Service Broker [RevocationFlag] [bit] NOT NULL,
[IsRevecation] [bit] NOT NULL) ON [PRIMARY]
# [J Storage 50
# [ Security v
# [J RMSLog W% -« mn >
< - w T T S | 4] Connected. (1/1) DRS (1.0 RTM) | sa(53) = RMSExtService | 00:00:00 | 0 rows

f)  Grant RMS administrator the database operations rights.

i Open “Internet Information Services” (lIS).

ii. Click “Application Pools” in Connections Pane. Then you can get the account
information from Identity column.
€

Internet Information Services (I1S) Manager

@0 ‘Q v DRS » Application Pools

File View Help

qsl Application Pools

This page lets you view and manage the list of application pools on the server. Application pools are associated with worker processes, cor

applications.
ez Filter: - Go - gyShow All | Group by: N Grouping -
4 € Default Web Site Name = Status  NETFram.. Managed Pipel... |dentity Applications
4 '-? _wmes . ‘;‘\‘NETVA.S Started v Integrated ApplicationPoolldentity 0
b qadm_;_" . L5} NET v4.5 Classic Started w40 Classic ApplicationPoolldentity 0
b \F‘V ;E’tl Kat'_m {1} _DRMSAppPool1 Started w40 Classic LFR |
- decommission
»-E» groupespansion |} DefaultAppPool Started  vA.0 Integrated Applica 2
p (2 licensing
b2 famsext
I -] aspnet_client
iii. Open SQL Server management.
H H ", H ”n " H ”n
iv. Navigate to “Security” -> “Logins”.

V. Check if the RMS administrator account is listed.





s CreateDatabaseRMSExtService.sgl - DRS.RMSExtService
File Edit View Query Project Debug Tools Window Help

P10l S e @ | Sl NewQuery [y i | 6 A @[ <
Q#MHRMSE}CI:S&MC& '|| § Execute B Debug ¥ o |

Object Explorer

Connect= 3 & w 7 #] ﬁ

U WS5_Logging ~
= [ Security
= [ Logins
&, ##MS_PolicyEventProcessingLogin#
&, ##MS_PolicyTsqlExecutionLogin®#
A FRMS\Administrator
4 FRMS\rms_lo
% FRMS\rms_service I
% FRMS\sp_admin
A NT AUTHORITY\SYSTEM
£ NT Service\MSSQLSERVER
A NT SERVICE\ReportServer
A NT SERVICE\SCQLSERVERAGENT
A NT SERVICE\SQLWriter
& NT SERVICE\Winmgmt
& sa
[ Server Roles
[ Credentials
Ca Cryp.tographic Providers -
< m >

o

If yes, skip to Step vi.
If not, right-click “Logins”, then click “New Login”.
s CreateDatabaseRMSExtService.sql - DRS.RMSExtService

File Edit View Project Debug Tools Window Help
Pl D e | L NewQuery [y i i Ty | 4 0 ] 4

i 2 9 | [RmsExtservice | ¥ Bxecute P Debug ® |
Object Explorer -1 x
Connect~ 3 3 m F [&] .5
U WSS_Logging ~
= [ Security
i
&8, 22 Mew Login... in##
&, #2 Filter y
AR | —
A FR Start PowerShell
& FR Reports 4
AR

A NT Refresh
A NT Service\MSSQLSERVER
& NT SERVICE\ReportServer
A NT SERVICE\SQLSERVERAGENT
A NT SERVICE\SQL Writer
A NT SERVICE\Winmgmit
A sa
[ Server Roles
[ Credentials
Ca Cryp!tographic Providers o

< m ¥
S S S S S S Sl

Input the Login name, click OK.





Select a page

Scrpt ~ Hel
12 General g H IE .
1 Server Roles
12 User Mapping Login name: |FHMS\n‘ns_service | | Search... |
12 Securables ® )
% Status Windows authentication
() SQL Server authentication
Password: | |
Corfirm password: | |
[] Specify old password
Old password: | |
Enforce password policy
Enforce password expiration
User must change password at next login
) Mapped to cegtificate | v|
() Mapped to asymmetric key | v|
[] Map to Credential | v || Add
Server: Mapped Credentials Credential Provider
DRS
Connection:
53
37 View connection properties
Progress Remove
Ready Default database: |master b |
Default language: | <defautt> hd |
ok | [ Cancel |
£
vi. Grant RMS administrator as the database owner.
5 Seript v [ Hep
Users mapped to this login:
Securables Map Database User Default Schema |~
[ Status O Report Server
El SExtService | FRMS\ms_service dbo =
l_l —
O Search_Service_Appli... =
O Search_Service_Appli... L
O Search_Service_Appli...
O Search_Service_Appli...
[ Secure_Store_Service... ||
[T SharePairt AdminCon v
[[] Guest account enabled for: RMSExt Service
Database role membership for: RMSExt Service
Connection
[] db_accessadmin
Server: [] db_backupoperator
RMS [] db_datareader
Connection: (] db_datawriter
FRMS"administrator [] db_ddiadmin
&7 View connection properties Ll db'dewdatareer
. ] publi
public
Ready
ok | [ coneel |
TRV
g) Set up the firewall.
i In SQL Server Configuration Manager, expand SQL Native Client Configuration, and

click “Client Protocols” and right-click “TCP/IP Properties” to get the default port.






= Sql Server Configuration Manager

File Action View Help

> #n|E= 0
{8 SOL Server Configuration Manager (Local) || Name Order Enabled
B QL Server Services %~ Shared Memory 1 Enabled
4. 50L Server Network Configuration (32bit| [5=Tcp/p 2 Enabled |
3 g SQL Native Client 11.0 Configuration (32 [ 5= Named Pipes E) Enabled

b H. s0L Server Network Configuration

Protocol
Enabled Yes
Keep Alive 30000
Keep Alive Interval 1000
Default Port
Default port on which connection will be made
< o HE ok [ concel [[ ety [[ Hep |

Run “Windows Firewall” and click “Advanced settings”.

@ @ - 1 |‘ » Control Panel » System and Security ¢ Windows Firewall v G| | Search Control Panel » |

Help protect your PC with Windows Firewall

Control Panel Home
‘Windows Firewall can help prevent hackers or malicicus software from gaining access to your PC through the

Allow an app or feature Internet or a network.
through Windows Firewall
@ Change notification settings l @ Domain networks Connected @
@ Turn Windows Firewall on or X
Metworks at a workplace that are attached to a domain

off
@ Restore defaults

Windows Firewall state: On
Black all connections to apps that are not on the list

Incoming connections:
of allowed apps

Troubleshoot my network

Active domain networks: E frms.com
Motification state: Do net notify me when Windows Firewall blocks a
new app
l @ Private networks Not connected ®|
. @ Guest or public networks Not connected ®|

See also
Action Center

Metwork and Sharing Center

Click “Inbound Rules”.





File Action View Help

ewall with Ad
I

indows Fir i
o]
!‘l‘ Connection Security Rules
1+ %l Monitoring

Name

@saL1433

@Taamwewer Remote Control Application
@Taamwewer Remote Control Application
@Taamwewer Remote Control Service
OTEame\MEr Remote Control Service

. BranchCache Content Retrieval (HTTP-In)
. BranchCache Hosted Cache Server (HTT...
. BranchCache Peer Discovery (W5D-In)

. COM+ MNetwork Access (DCOM-In)

. COM+ Remote Administration (DCOM-In)
@ Core MNetworking - Destination Unreacha...
0 Core Networking - Destination Unreacha...
0 Core Networking - Dynamic Host Config...
0 Core Networking - Dynamic Host Config...
0 Core Networking - Internet Group Mana...
@ Core Metworking - IPHTTPS (TCP-In)

(@ Core Networking - IPv6 (IPv-In)

@ Core Metworking - Multicast Listener Do...
@ Core Metworking - Multicast Listener Qu...

0 Core Networking - Neighber Discovery A...

OCore Networking - Multicast Listener Rep...
OCore Networking - Multicast Listener Rep...

Inbound Rules

Group

BranchCa
BranchCa
BranchCa
COM+ N

COM-+ Re
Core Nety
Core Nety
Core Netv
Core Netv
Core Netv
Core Netv
Core Nety
Core Nety
Core Nety
Core Nety
Core Netv
Core Netv

[<] ] [3]

(<[ m

|

w

W3 NewRule..
Filter by Profile

'
'
'

Filter by State
Filter by Group
View

Refresh

Export List...

BiD

Help

- vy v -

Click “New Rule...”.

File Action View Help

= z7E = B

‘ ‘Windows Firewall with Advance

nbound Rules

Outbound Rules
' Connection Security Rules
1 %l Monitoring

Inbound Rules

Mame

@saL1433

@Teamviewer Remote Control Application
@Teamviewer Remote Control Application
@Teamviewer Rernote Control Service
@Teamviewer Rernote Control Service
.Bran(hCachE Content Retrieval (HTTP-In)
.Bran(hCachE Hosted Cache Server (HTT...
.BranchCache Peer Discovery (W5D-In)

. COM+ Network Access (DCOM-In)

. COM+ Remote Administration (DCOM-In)
@Core Metworking - Destination Unreacha...
@Core Metworking - Destination Unreacha...
@Core Metworking - Dynamic Host Config...
@Core MNetworking - Dynamic Host Config...
@Core Networking - Internet Group Mana...
@CDrE Networking - IPHTTPS (TCP-In)
@CDrE Networking - IPvb (IPvb-In)

BCnre Networking - Multicast Listener Do...
@Core Netwaorking - Multicast Listener Qu...

@Core Metworking - Multicast Listener Rep...
@Core Metworking - Multicast Listener Rep...
@Core Metworking - Meighbor Discovery A..

Group

BranchCa
BranchCa
BranchCa
COM+ Ne
COM+ Re
Core Metv
Core Metv
Core Metv
Core Metv
Core Metv
Core Metv
Core Metv
Core Netv
Core Metv
Core Metv
Core Metv
Core Metv

New Rule...

'
'
'

Filter by Profile
Filter by State
Filter by Group
View

Refresh

Export List...

BB

Help

v

(<] [ [>

<[

[>]

r v v ¥

Select “Port” and then click “Next”.





Rule Type
Select the type of firewall rule to create.

Steps:
Rule Type
Protocol and Ports
Action
Profile

What type of rule would you like to create 7

) Program
Rule that controls connections for a program

Name

@® Port
Rule that controls connections for a TCP or UDP port.

) Predefined:
| BranchCache - Content Retrieval (Uses HTTF)

Rule that contrals connections for a Windows experience.

) Custom
Custom rule.

vi. Select “TCP”, then select “Specific local ports”, type the SQL port number, and click

“Next”.

Protocol and Ports
Specify the protocols and ports to which this rule applies.

Steps:
@ Rule Type

@ Protocol and Ports
@ Action

@ Profile

L

Name

Does this rule apply to TCP or UDP?

® TCP
O upP

Does this rule apply to all local ports or specific local ports?

O All local ports

® Specific local ports: | 1433
Example: 80, 443, 5000-5010

<Back || MNed> |[ Cancel

vii. Select “Allow the connection”, and then click “Next”.





Action
Specify the action to be taken when a connection matches the conditions specified in the rule.
Steps:

Rule Type
Protocol and Ports

What action should be taken when a connection matches the specified conditions?

i ® Allow the connection
Action This includes connections that are protected with |Psec as well as those are not.
Profile

N () Allow the connection if it is secure
ame This includes only connections that have been authenticated by using IPsec. Connections
will be secured using the settings in |Psec properties and rules in the Connection Security
Rule node.

) Block the connection

viii. Choose when to apply the rule.

Profile
Specify the profiles for which this rule applies.

Steps:
Rule Type

Protocol and Ports

Action [+] Domain
Applies when a computer is connected to its corporate domain.

‘When does this rule apply?

Profile

Name ] Private
Ppplies when a computer is connected to a private network location, such as a home
or work place.
v Public
Applies when a computer is connected to a public network location.

iX. Specify the name and description of the rule and then click “Finish”.





Name

Specify the name and description of this rule.

Steps:
Rule Type
Protocol and Ports

Action
Profile Name:

[saL 1433

Name

Description (optional):
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